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log environment with a beta deck or other analog gear. Its built in key
channel enables the O2 to integrate into broadcast and post environ-
ments.
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PREFACE

This manual provides complete application, installation,
setup and user information for the MultiBuffer DS-1
Networkable Video Gateway. It also includes complete
information on using Envoy Mac and Envoy PC control
applications and a section covering Unix control.

The manual is divided into the following sections:

Overview

This section describes the main uses of MultiBuffer 
DS-1 and gives examples of common applications.

Installation

Installation of MultiBuffer DS-1 to external video and
networking devices and setting the frame front panel
controls for system parameters are covered in this
section.

Control with Envoy Mac Software

Control of MultiBuffer DS-1 with Ensemble’s Envoy
Mac software (v3.0 or later) is provided in this section.

Control with Envoy PC Software

Control of MultiBuffer DS-1 with Ensemble’s Envoy PC
software (v1.4.2 or later) is provided in this section.

Control With SGI or Unix Platforms

Using an SGI/Unix workstation to control MultiBuffer
DS-1 is described in this section.

Troubleshooting

This section gives MultiBuffer DS-1 troubleshooting
tips.

Product Specifications

Complete product specifications are provided in this
section.
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MULTIBUFFER DS-1 OVERVIEW

The MultiBuffer DS-1 is the perfect video gateway for
transferring graphics between your computers and the
video world. Flawless transfers are possible with
utilization of sophisticated transcoding algorithms for
taking computer based images into 601 component
digital at full 10-bit resolution. Uncompromised picture
quality is guaranteed by precision color space
conversions between the computer work of RGB and
digital video’s Y, R-Y, B-Y (also called YUV). Accurate
conversions are ensured every time with the uncom-
pressed digital video path and 16-bit computation.

As a networkable device, the The MultiBuffer DS-1
connects easily to an existing Ethernet network,
making it available to all computers and workstations
in your facility. No video plug-in cards are needed. and
any computer can use this system, even a laptop.
Support of TCP/IP and Appletalk/Ethernet enables full
platform independence and simultaneous support of
multiple computers.

Access by any workstation or computer to the
MultiBuffer DS-1 is possible through Envoy Mac,
Envoy PC or UNIX commands. Full control of Input
Selection, Freeze, Timing Control and Output Routing
are accessed directly from the desktop.

MultiBuffer DS-1 can have up to 4 live digital inputs, 4
digital outputs, and 4 internal SmartStore™
FrameBuffers. Serial digital inputs and outputs make
integration into a component digital suite simple. In
conjunction with the MultiBuffer DS-1, Ensemble’s
Serial Box™ Digital and Analog Converters offer
multiple solutions for interfacing to all types of video
environments.
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Signal routing in the MultiBuffer DS-1 is flexible with
a 12x14 internal routing switcher, providing a
complete interconnect between inputs, outputs and
framebuffers. Simultaneous output of video and key
(alpha) signals essential for proper keying are also
provided.

The MultiBuffer DS-1 genlocks to analog color black,
composite sync or 601 digital sources. The output
timing of each SmartStore FrameBuffer is indepen-
dently adjustable. Selectable frame or field playback of
captured images is provided. 

With the optional Catalyst Switcher upgrade, you can
add complete keying capability to the MultiBuffer 
DS-1. The Catalyst CV Combiner module plugs into
the video board inside the MultiBuffer chassis.
Catalyst can use both the internal framebuffers and
live video sources for background and key material.It
can be used as a production switcher with traditional
cut, mix and wipe functionality.

Programmable logic and innovative software keeps the
MultiBuffer DS-1 flexible, ensuring a long life in every
facility.
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Applications
Moving graphics from your computer or client’s files to
601 video is a simple process with the MultiBuffer 
DS-1 as shown in the figure below. Video and Key from
the MultiBuffer DS-1 can be fed to your router,
production switcher or paint system eliminating the
need to tie up your DDR to transfer stills. Video stills
can be captured and accessed easily from any computer
in your facility.

You can create a powerful still store system by
combining the MultiBuffer DS-1 and a workstation
with your graphics stored on a hard drive. The
intuitive front end and industry standard computer
tools for browsing and sequencing make saving and
retrieving graphics a natural extension of the
MultiBuffer DS-1.

10

MultiBuffer DS-1Overview

Networking MultiBuffer DS-1 Application



The MultiBuffer DS-1 combined with a workstation is
a flexible and cost effective alternative to dedicated
character generator with the added advantage of
virtually limitless typefaces.

Use the MultiBuffer DS-1 for calibrating your
computers and your video equipment with the built-in
test signal generator.

The MultiBuffer DS-1 is right at home on virtual sets.
With up to four frames of delay, timing issues are
easily resolved. Add the Catalyst option for a complete
switcher and chroma keying solution.

11
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INSTALLATION

The MultiBuffer DS-1 frame electronics is 1 rack unit,
19” wide, 1.75” high and 17” deep and weighs 12
pounds. Rack ears are included and screw onto the
sides of the frame chassis for rack mounting. Rear rack
supports are also included. Power specifications are
100-230 VAC, 50/60 Hz, 60 VA. CE Compliant where
required.

The external connections to the MultiBuffer DS-1
backplane are explained in the following sections. The
backplane is illustrated on the next page.

Inputs
The MultiBuffer DS-1 can have up to 4 Serial Digital
259M inputs with reclocked active loopback outputs.
All inputs have an 8 line autotime window. The system
comes standard with 2 inputs.

Connect the desired sources to the active Serial
Component Input BNCs on the back of the frame
electronics. (Inputs 1 and 2 are standard, inputs 3 and
4 are optional). Catalyst accepts serial digital SMPTE
259M video. Use 75 ohm coaxial cable for connecting
the inputs.

Outputs
The MultiBuffer DS-1 can have up to 4 independent
Serial Digital 259M output channels, each with an
additional buffered output.

Connect the active Serial Component Output BNCs to
the desired output destination. (Outputs 1 and 2 are
standard, outputs 3 and 4 are optional). Outputs can
be fed to any device that accepts serial digital video
SMPTE 259M video. Use 75 ohm coaxial cable to
connect the outputs.
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Buffers
The MultiBuffer DS-1 can have up to 4 internal
SmartStore™ FrameBuffers installed. Two buffers are
standard and two are optional.

Each buffer holds 1 frame of video and can be frozen or
unfrozen. The video in a buffer can come from 3
sources; a digital video input, via ethernet from a
workstation, or an internal test pattern. Also, the
MultiBuffer DS-1’s internal routing system allows
routing of one buffer to another, which can be helpful
for special timing needs. Each buffer can be indepen-
dently timed and can provide up to 1 frame of delay as
needed. (For most applications, buffers do not need to
be timed.)

Reference Inputs
There are four sync reference source choices available
as listed below: 

• Analog A

• Analog B

• Digital Input #1

• Freerun

One of these sources must be chosen as the sync
reference in the Genlock & Timing selection through
the front panel controls explained in the next section.

Analog Reference A or B

Two BNCs are available on the back of the frame
for use with analog reference signals. The analog
reference signal must contain composite H and V
sync, at any level from 300 mV to 4 V peak-to-peak.
Standard color black from a Sync Pulse generator is
a good choice for a reference source.

14
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The two BNCs can be set for a standard loop-
through mode or for each BNC to be an
independent reference input. Internal jumpers on
the main video board must be set to configure these
two connectors as either high-impedance loop-
through or independent, internally terminated
inputs. The jumpers are set at the factory for loop-
through mode.

If you desire to use the independent mode, remove
the top cover of the frame electronics and locate the
jumpers, J9 and J10, located at the rear of the
main circuit board behind the Ref A and B BNCs.
Move the jumpers to the right most two pins as
illustrated in the figure below.

To use the loop-through mode, connect the analog
reference signal to one of the BNCs and loop
through to the next device. You will need to set the
Genlock Source to Analog Ref A or B when setting
the front panel controls in the next section.
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If you have set the jumpers for two independent
inputs, you can feed two different reference signals
to the Analog Ref A and B (such as 525 and 625)
and in the next section, set the Genlock Source for
either A or B depending on which reference signal
you want to use.

Digital Input #1

When genlocked to Digital Input #1, the 27 MHz
clock and Horizontal and Vertical timing are
derived from the input signal feeding Digital Input
#1. For this setting, choose Digital Input 1 under
the Genlock Timing menu. (Note that an external
digital signal input must be connected to Input #1
for this setting.)

Freerun

When freerun is selected, an internal sync
generator, driven by the internal 27 MHz crystal
oscillator, provides the reference signal. No cabling
is required. Select Freerun under the Genlock
Timing menu for this setting.

Editor Port
The editor port uses a standard 9-pin D connector and
is used with the optional Catalyst module if installed.

16

MultiBuffer DS-1 Installation



Diagnostic Port
The diagnostic port is not used at this time.

Control Panel
The control panel is available if you are using the
optional Catalyst module.

Computer Network Connections
The MultiBuffer DS-1 frame supports 10 Mb Ethernet.
Your MultiBuffer DS-1 frame has either a 15 pin AUI
Ethernet connector or BNC (Thinnet), depending on
how you ordered it.

Ethernet setup, including IP address management, and
status checking is done through the front panel
controls. Refer to the next section, Frame Front
Panel Operation for more details.

To connect to the Ethernet port, refer to the instruc-
tions below.

10BaseT 15-pin AUI Connection

To use 10BaseT, an external transceiver must be
installed to the 15-pin AUI connector (to the upper
left of the LAN phone connections). Conventional
10BaseT cabling is then run from that transceiver
to the hub serving the system. 10BaseT installa-
tions require a central hub to which each network
device connects. A properly installed 10BaseT
connection will illuminate the “link” indicator on
the transceivers at the frame and at the hub.

Optionally, an Ethernet crossover cable can be
connected between the MultiBuffer DS-1
workstation and the system device in lieu of a hub.
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Thinnet BNC Connection

Thinnet cabling runs daisy-chain fashion to all
devices on the network. The frame can be equipped
with an optional single female BNC for connection to
the network via a Female/Male/Female T-connector.
50 ohm coax (RG58) is run between each device, with
a 50 ohm termination on the unused half of the 
T-connector at each end of the chain.

GPI/Remote
The GPI interface connector is a 15-pin male connector
with the pinouts as shown in the figure below.
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The following engineering points should be considered
when connecting the GPI inputs and outputs:

1. GPI inputs are active low, sampled at the
vertical interval.

2. GPI outputs require 470 ohms to LED when
using a lamp driver.

3. When GPI Output is used as a logic output, do
not use a pullup resistor. Use a 1N4148 diode in
series with the load for isolation, with cathode
towards the frame for active low.

4. GPI operation requires MultiBuffer DS-1 with
0.9.4b27 or later PROMs.
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Frame Front Panel Operation
Setup of the frame system parameters is done through
the front panel controls of the MultiBuffer DS-1 frame
electronics. The top level menu choices for the
parameters to be set are as follows:

• Buffer Control

• Router Control

• Genlock and Timing

• Remote Port Mode

• Edit Port Mode

• Network Status

A full menu tree describing each menu setting is
provided in Appendix A of this manual.

The controls for setting the menu functions are located
at the front of the MultiBuffer DS-1 frame as shown
below. Each menu function is explained in detail in this
section.

To access the menus, press the Menu Func button so
it is lit and observe the LCD display to the right. Use
the RIGHT , LEFT , UP and DOWN arrow keys to
scroll through and select the menu choices where
instructed and use the ENT button to make your
selection.
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LCD Contrast Adjustment

To adjust the contrast of the LCD display, press
and hold down the menu button and use the UP
and DOWN arrow keys to adjust the light and dark
contrast as desired.

Buffer Control
Each framebuffer can be set for the following
parameters:

• Make Test Patterns

• Freeze Control

• Buffer Timing

• Set Default

Scroll to Buffer Control and then enter the desired
function by pressing the DOWN arrow when it
appears on the screen. 

Make Test Patterns

If you would like a Test Pattern written into a
buffer, select the Make Test Patterns selection
and choose the Pattern Function from the
following:

• Make 442 Patterns

• Make 444 Patterns

• Set Pattern IDs
Make 422 Patterns

Scroll to the Buffer (1-4) into which you would like
to store the pattern and then scroll to the pattern
you would like and press ENTER . There are 16
patterns available, refer to the foldout menu tree in
Appendix A for a complete listing.
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Make 444 Patterns

Two buffers are required to store a 444 pattern.
Buffer pairs are selected in the menu. Scroll to the
Buffer combination (Buffers 1 & 2, 2 & 3, 3 & 4,
and 1 & 4) into which you would like to store the
pattern and then scroll to the pattern you would
like and press ENTER . There are 3 patterns
available in this selection:

• YCrCb Bars

• RGB Bars

• Pulse and Bars
Set Pattern IDs

Each pattern can be embedded with a 4-digit text
or number ID for identification. The ID can be
positioned horizontally and vertically as desired.
Set the pattern ID as follows:

Scroll to Set Pattern IDs with the DOWN arrow.
To Set ID Text , use the RIGHT and LEFT arrows
to scroll to each digit, then use the UP and DOWN
arrows to select the desired character. Press
ENTER to make your selection.

Then, to enable the ID, scroll to Turn ID On or
Off and select ON or OFF .

You may then set the horizontal and vertical
positioning of the ID. Scroll to Set ID Vert Pos
and choose from the following vertical positions:

• Top

• Top-Center

• Center

• Bottom Center

• Bottom
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Scroll to Set ID Horiz Pos and choose from the
following horizontal positions if desired:

• Left

• Center

• Right
Freeze Control

The next function under the top level Buffer Control
is Freeze Control . You may let video run through
a buffer or freeze it at a desired point. Scroll to the
desired buffer 1-4 then set the freeze control to ON
if desired.

Buffer Timing

Generally, buffer timing does not need to be
adjusted. H and V are generally both left at 0 which
causes the buffer output to be in time with the
reference.

In special cases, you may want to adjust buffer
timing. This can be handy when routing an input
through one or more buffers in order to achieve one
or more frames of delay. A maximum of one frame of
delay can be achieved per buffer.

Setting vertical timing to a negative number causes
the buffer output to be early with respect to the
reference. A positive number would result in the
buffer output being later with respect to the
reference. Vertical timing is adjusted in lines;
horizontal timing is adjusted in clocks.

Scroll to Buffer (1-4) V Timing to make vertical
timing adjustments.

Scroll to Buffer (1-4) H Timing to make horizontal
adjustments.
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Set Default

After setting a buffer to Freeze or Unfreeze ,
selecting a test pattern (if Freeze was chosen) and
adjusting timing as needed, scroll to the desired
buffer and press ENTER to save these settings into
non-volatile memory.
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Router Control
MultiBuffer DS-1 has a 12 x 14 internal routing
switcher, this allows any input to feed any buffer or
output and any buffer to feed any other buffer or
output. Refer to the functional block diagram on the
next page for a pictorial view of how the router
processes signals throughout the system and to help
you choose the routing setups.

Each source is assigned to a destination using this
menu function. The menu tree in Appendix A shows a
complete list of the source and destination choices.

Enter the Router Control menu, then use the UP and
DOWN arrow keys to scroll to the source. Use the
RIGHT and LEFT arrow to scroll to the desired
destination for this source. Hit ENTER to make your
selection. “Take” will briefly be displayed to confirm the
routing change has occurred.

Genlock & Timing
This menu selection consists of the Genlock Timing
and the Line Standard selections. As explained
earlier in the Cabling section, the system must be
genlocked to either an external analog house sync
reference or Digital Input # 1 or it may freerun.

Scroll to the Genlock Source selection and choose the
sync reference you will be using. Choose from Analog
Ref A, Analog Ref B , Digital Input #1 or Freerun .
If you are not sure which reference to use, refer back to
the Reference Inputs heading earlier in this section
for an explanation.

Scroll to the Line Standard and select either 525 or
625 lines depending upon your line rate requirement.
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Remote Port Mode
This function defaults to GPI (Remote Port is not
used).

Edit Port Mode
The Edit Port Mode is mainly used when the optional
Catalyst module is installed. Use this function to set
the desired protocol.

• Off (if the Edit Port will not be used)

• Mac Remote (if you are using Ensemble’s
InMotion Macintosh software)

• Linc Peripheral (If you are using an Abekas
A83 Production Switcher. You must select a
LINC Address ID from 1-32)

• GVG 200 (Emulates the Grass Valley 200
protocol).

Network Status
This top level menu provides 3 network status choices
as shown below:

• AppleTalk

• Ethernet

• Buffer Names

If you are using LocalTalk, select AppleTalk to
identify and initialize the AppleTalk node.

To check your Ethernet status, scroll to Ethernet .
Press ENTER for the status of your Ethernet
connection. It should read Good Connection . If it
reads No Transceiver or Bad Term , check your
Ethernet network for proper cables, connection, trans-
ceivers and terminations.
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(NOTE : Be sure your workstation’s Ethernet port is
active.)

You can check the Ethertalk net and node addresses by
scrolling to Net and Node under this menu. You can
also identify the ethertalk Zone under this menu.

To set your Ethernet IP address, scroll to IP Address
and enter the address (in base 10) and press ENTER .

In the Buffer Names menu, each buffer must be
assigned a unique name. Use the RIGHT and LEFT
arrows to move between each digit in the name and the
UP and DOWN arrows to select the characters.

This completes the front panel control menu setups for
the MultiBuffer DS-1.
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CONTROL WITH ENVOY MACINTOSH SOFTWARE

Overview
The Envoy™ Digital Image Transporter (v3.0 or later)
transforms Macintosh® computer graphics into ITU-R
601 Digital Component, NTSC Analog, or Digital
Composite output for production work. Envoy utilizes
precision numerical transcoding of the image,
producing the same high quality result expected from
expensive digital hardware encoders and transcoders.
The transcoded image is then transmitted over
Ethernet to a framebuffer in any of the MultiBuffer™
DS-1 or DS-2 devices in the facility.

Images that have been captured within any
MultiBuffer may also be transferred back to Envoy
over the network. The image is then decoded or
transcoded using precision algorithms and may be
saved either as a 32 bit PICT file or in its original
digital component or encoded digital composite form.
Since the entire path is digital, the encoded image can
be sent back to the MultiBuffer without any loss or
artifacts common with analog encoders, decoders, and
transcoders.

Multiple buffers in the DS-1 and DS-2 allow simultane-
ous use of video and alpha (or key) signals for graphics
layering in analog or digital production switchers.

The MultiBuffer DS-1 can run at 525 and 625 line
rates. Envoy comes in two versions: Envoy 525 and
Envoy 625. The MultiBuffer DS-1 can be used with
Mac, Silicon Graphic and NT machines. Contact
Ensemble Designs if you need a copy of Envoy PC or if
you need Silicon Graphics interface information.

The MultiBuffer DS-2 runs in 525 only and can be
used with Macintosh.
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System Requirements
Envoy Software version 3.0 requires Apple's System
7.1 or newer. However, System 7.5 is required if you
wish to take advantage of the Macintosh Drag and
Drop features in Envoy. Envoy is Power PC
compatible.

Envoy communicates with the MultiBuffer DS-1 over
an AppleTalk™ network using either the Ethernet port
or LocalTalk port on your Mac. In either case, the
proper cabling is required to accomplish the intercon-
nection.

Ethernet is standard on the MultiBuffer DS-1. It will
have either a BNC for thinnet or an AUI connector and
a transceiver for use with thinnet or 10BaseT.

It is also equipped with a dual, or looping, RJ-11
(modular phone) connector for using LocalTalk.

You may need a compatible transceiver for the
Macintosh along with other cabling and terminations.
These connectors, cables, and transceivers are readily
available through catalogs and computer outlets, or
contact us at Ensemble Designs if you need assistance.
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Installation
Hardware

A simple Ethernet connection requires either an
AAUI (Apple Attachment Unit Interface) for Macs
with built-in Ethernet or an Ethernet card installed
in the Mac. If you're not connecting to an existing
Ethernet network, the simplest solution is to use
ThinNet cabling (also referred to as 10Base2) which
uses RG-58 cables between each device in a daisy-
chain orientation. Each device is connected to the
network using a BNC "T", with a 50W termination
at each end of the network.

If your installation is more elaborate, or you have
an existing AppleTalk™ system, refer to the docu-
mentation for the wiring system you are using or
your network administrator. In all cases, the
MultiBuffer can be regarded as just another
network compatible device, one which already has
either the RJ-11 or Ethernet connectors built in.

Alternately, you may use a Macintosh equipped
with a LocalTalk interface node. The LocalTalk
interface connects to the printer port of the
Macintosh. This interface unit, which is also
equipped with a dual RJ-11 connector, is intercon-
nected to the MultiBuffer using ordinary modular
phone cable. The unused RJ–11 connectors on the
MultiBuffer and the LocalTalk interface should
each be terminated with the 100 W resistors that
are included.
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Software

Envoy and supporting files are supplied on a high
density 1.4MB 3.5” floppy disk. Make sure this disk
is write protected and do not alter it in any way.
The Envoy program file may be copied to any
convenient location on your hard disk.

Using Envoy
To run Envoy, simply open (or double-click) the Envoy
application icon. Envoy version 3.0 is completely self-
contained and does not depend on any other files for its
network access.

The first time you run Envoy, a preference file is
created in your System folder that remembers most of
the settings you select. This file is updated every time
you leave Envoy so that your personal settings are
automatically saved for the next time.

When Envoy is opened, an Envoy Picture window will
appear, which will be blank if the Envoy application
was launched without selecting a document. This
window displays the picture currently in Envoy
memory. Internally, the picture is always stored as a
484 x 640 (or 484 x 768 for digital composite or 487 x
720 for digital component) 32 bit image which includes
24 bits of RGB information and 8 bits of optional alpha
information.

The Envoy Picture window size may be changed and
placed at a convenient location on your screen - this
does not change the internal storage of the image. The
window may also be hidden by selecting Hide Picture
Window from the View menu (or by just clicking in
the window's close box). This simply hides the window
and has no affect on the stored image. Refer to the
section on The Envoy Picture Window for more
information.
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Primary and Alpha Buffers

Envoy defines a path to two default buffers, a
Primary buffer, which receives the encoded or
transcoded picture or video fill, and the Alpha buffer,
which receives the monochrome, or key, portion of a
picture. When capturing a picture, the 24 bit color
image comes from the Primary buffer and the 8 bit
alpha information comes from the Alpha buffer.

Selecting Default Buffers

Before sending a picture to a buffer, you need to
select the default buffers for the application. To do
this, choose Select Buffers from the MultiBuffer
pulldown menu. A buffer selection dialog will appear,
as shown below. This sets the default buffers that
the Envoy pulldown menus use. The PhotoShop
plug-in also looks at this default selection.
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Assuming at least one MultiBuffer is connected to
your network, a list of all available buffers will
appear. The current buffers, if already selected, are
shown at the bottom.

To choose a new or different default buffer, first
select the buffer from the list and then click on
either the Primary (video fill) or Alpha (key)
buttons. A connection to the buffer will be opened
and, if there are no communications problems, that
buffer will appear as the current default buffer.

NOTE : You may also double-click a buffer in the list
to select it as the Primary buffer or hold down the
Option key and double-click a buffer to select it as
the Alpha buffer.
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BufferPorts

A BufferPort is a special Envoy window that can be
placed anywhere on the screen. From Desktop , you
can drag a PICT file, or an Envoy file, to any
BufferPort and the picture will immediately be sent
to the buffer defined by that port. Up to 20
different BufferPorts can be defined.

When the BufferPort is first created, it's displayed
in it's small size, as shown in the top figure below.
The BufferPort can be expanded by clicking on the
small triangle which reveals the Freeze , Capture ,
and Input controls, as shown in the lower figure.
Clicking the triangle again will shrink the
BufferPort. To move the BufferPort, click anywhere
in the shaded area of the window and drag it to the
desired location.
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Working With BufferPorts

When the BufferPort is expanded as shown in the
previous figure, the Freeze and Capture buttons
and Input menu appear. The button will highlight
to indicate the current Freeze state. Clicking on the
Capture button starts a capture from the selected
buffer.

NOTE: Option-clicking the Freeze button will turn
off the Freeze for 2 frames and then turn the
Freeze back on, capturing the current input video
of the MultiBuffer.

Clicking on the Input pop-up menu presents a list
of inputs that may be selected for the BufferPort's
buffer and allows selection of any of those inputs.
The MultiBuffer allows you to select any available
input or another buffer.

Normally, the BufferPort only needs to be expanded
when capturing pictures; otherwise, it can be left at
the normal size.

To close a BufferPort, click the close box in the
BufferPort window. This will permanently remove
the BufferPort. Any BufferPorts remaining when
you quit Envoy are saved and will return next time
Envoy is run.

Creating a New BufferPort

To create a new BufferPort, select New
BufferPort from the File pulldown menu. A
window, similar to the one on the following page,
will appear. This window allows you to assign a
primary and an optional alpha buffer to a new
BufferPort. Either select a buffer from the list and
click on the Primary button or double-click a buffer
selection to assign that buffer as the BufferPort's
primary buffer.



A BufferPort can also be assigned an alpha buffer.
Selecting Dual Port will cause a second button
and a line for the Alpha buffer to appear. To add
an alpha buffer, either select a buffer from the list
and click on the Alpha button or double-click a
buffer selection while holding down the Option
key.

Once the buffers are selected for the new
BufferPort, click OK to create it. A new BufferPort
will appear at the center of the screen. 

If you need to change the buffer or buffers assigned
to the BufferPort, double-click the buffer name on
the BufferPort window. A Select Buffer window
similar to the one below will appear and allow you
to change the assigned buffer or add or remove an
alpha channel.
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Dragging a PICT or Envoy File to a BufferPort

Sending a picture to a BufferPort takes advantage
of Macintosh Drag and Drop. Locate the PICT or
Envoy component or composite file you wish to
transfer, and drag it onto the BufferPort represent-
ing that buffer you wish to send it to.

When the file is dragged onto the BufferPort, the
buffer's name will highlight indicating it recognizes
the file. Dropping the file on the BufferPort will
then immediately start a transfer to its assigned
buffer. If the BufferPort is set up as a DualPort,
then the alpha portion of the file (PICT files only)
will be sent to the alpha buffer selected for that
BufferPort.

If you don't need to view the file you're sending, you
can speed up the transfer by first closing the Envoy
Picture window. This reduces the need to display
the picture, especially if the Envoy Picture window
is reduced in size.

The most efficient transfer occurs when using an
Envoy Encoded or Component picture. Since this
file already has the transcoded image, it saves a
considerable amount of time by not having to
expand, filter, and encode/transcode the RGB
picture. Just drop the Envoy picture file onto a
BufferPort and it will start transferring
immediately.

Note that the transfer may take place in the
background. You may click on an Envoy window to
bring Envoy to the front and see the transfer status
box, although this isn't necessary.
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Capturing an Image from a BufferPort

To capture a picture from a BufferPort, first expand
the BufferPort window. You can use the Freeze
button if necessary to freeze the desired image.
Then, press the Capture button to start the
transfer of the image from the MultiBuffer to
Envoy. When the transfer is completed, the image
will be transcoded and shown in the Envoy Picture
window just like a capture from the default primary
buffer.

A captured image can be saved just like any other
Envoy picture. Refer to Saving a Captured
Picture for more information.

Loading a Picture

Before a picture can be sent from Envoy to the
MultiBuffer, it first needs to be loaded into memory.
Envoy can read either a PICT file or an Envoy
Component (DS-1) file, which is a previously saved
pre-transcoded digital component image, or an
Envoy Encoded (DS-2) file, which is a previously
saved pre-encoded digital composite image. There
are many ways to load an Envoy picture file or a
PICT image. Any of these methods replaces the
current picture with the one you're loading:

Selecting Open... from the File menu: A standard
Open File dialog will appear allowing you to load
any PICT file or Envoy Picture file.

Double-clicking a picture file in Finder. The image
in the file will be loaded by Envoy only if it was
saved by Envoy. Otherwise, the application creating
it will be opened.
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Dragging a picture file in Finder onto the Envoy
application icon: This will load the picture from
the selected file. Only PICT files or Envoy Picture
files will be recognized.

Dragging a picture file from Finder into the Envoy
Picture window: This will load the image from the
selected file. Only PICT files or Envoy Picture files
will be recognized.

Dragging an image from another Drag and Drop
aware application into the Envoy Picture window:
The image will be copied into Envoy. Refer to docu-
mentation for the graphic application you're using
to see if they support Macintosh Drag and Drop and
the picture selection process.

Dragging a picture file from the Finder or a
picture image from another application onto a
BufferPort. Refer to the section on the BufferPort
for more information.

Pasting a PICT image into the Envoy Picture
window: If you already have the picture you want
to use in the Clipboard, first select the Envoy
Picture window to make it active, then select Paste
from the Edit menu and the picture will be centered
and pasted into the window.
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Picture Size and Envoy

For 525/NTSC Applications

A MultiBuffer digital component picture buffer
allows for an active image area of 487 lines high by
720 pixels wide. However, since a standard NTSC
picture has an aspect ratio of 3:4, this results in
pixels that are not square. If you were to load in a
484 x 720 (or 768 for DS-2) picture and send it to
the MultiBuffer, the resulting video would be
compressed horizontally.

To overcome this problem, Envoy accepts a 484 x
640 picture and will automatically expand it hori-
zontally to fill in the 720 (for DS-1) or 768 (for
DS-2) pixels. This resulting video will therefore
have the exact same aspect ratio as the Mac picture
you created. When capturing images from the DS-1,
Envoy performs the reverse process and compresses
the 720/768 pixels down to 640.

Envoy can also work directly with 487 x 720 (for
DS-1) and 484 x 768 (for DS-2) pictures which it
will transfer directly to or from the MultiBuffer.
This is sometimes useful if the image is already
expanded, such as one that has been captured and
needs to be sent back out again without any
compression/expansion artifacts.

For 625 and PAL applications

Envoy 625, an alternate version of Envoy for
Macintosh, is used for 625/PAL applications on the
MultiBuffer DS-1 only. It does not perform auto-
resizing so images should be created in 640 x 480
or 720 x 576.

You can tell Envoy which size picture to expect by
selecting the picture Width in the View menu.
Normally, 640 should be selected, which tells Envoy
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to expand the picture when loading it. If 720/768 is
selected, the picture will not be adjusted as it's sent
to the MultiBuffer. Note that you must set this size
before you load the picture - the internal storage of
the picture will stay the same if you change this
setting after the image is loaded.

NOTE: Sending a 768 pixel image to a DS-1
component buffer is allowed, but requires Envoy to
first compress it to 640 pixels and then back up to
the size required for the format.

When a picture is loaded that is larger than 486 x
640, 487 x 720, or 486 x 768, Envoy will automati-
cally crop the image to fit the specified size. Each
side is cropped evenly so that the image will remain
centered.

Pictures that are smaller than the specified size are
also centered, with the border filled to white. A
special mode, Auto EdgeMatch , will automatically
fill in the border on the top, bottom, and both sides
with either black or the predominant color for that
edge of the picture. Auto EdgeMatch is selected in
the View menu and, like the size selection, only
affects pictures as they are loaded into memory.

The Envoy Picture Window

The picture currently loaded into Envoy memory is
displayed in the Envoy Picture window.
Internally, the picture is stored as a 487 x 720 or
484 x 768 pixel image with 24 bits of precision (plus
an 8 bit alpha channel). However, the window
displays the image in whatever mode your monitor
supports.

If you don’t have a monitor capable of a 24 bit
display, you can enhance the image by selecting
Dither in the View menu. This setting only affects
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the display in the Envoy Picture window - it has
no effect on the internal image to be sent to the
MultiBuffer, which is always encoded from the full
24 bit RGB picture.

To view the alpha component of the picture, select
Show Alpha from the View menu. If there is any
alpha information in your picture, it will be shown
as a grey-scale image. Extra memory is used while
in this mode, so it is best if the view is not left in
Show Alpha mode. Note that there is no edge-
matching of the alpha image.

The Envoy Picture window can be re-sized and
moved to any part of the screen using the standard
Macintosh grow or zoom capabilities. When the
window is shrunk, the displayed image will be
scaled down accordingly. The aspect ratio of the
window will always stay the same at any size.

Selecting a 720 or 768 window picture width will
change this aspect ratio to show the image
accurately in either setting. Sizing the window
using either of these methods has no effect on the
internally stored image, although the width setting
will affect how the next picture is loaded, as
described in the previous section.

To hide the Envoy Picture window, either select
Hide Picture Window from the View menu or
click on the close box of the window. Hiding the
window does not affect the internal image. To show
the window again, select Show Picture Window
from the View menu.

You can clear the Envoy Picture , including the
internal image in memory, by selecting Clear in
the Edit menu.
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All the settings in the View menu, along with the
position and size of the Envoy Picture window,
are saved when you quit Envoy and will be restored
next time Envoy is launched.

Sending the Picture Using Pulldown Menus

An alternate method of sending a picture besides
using a BufferPort, is to select Send Picture in the
MultiBuffer menu. Once the desired picture is
loaded into Envoy, you can send it to the
MultiBuffer selected as the primary buffer by. using
this function. A status box (illustrated below) will
appear indicating the destination buffer and will
display the progress of the picture transmission.
You can stop the picture transmission at any time
by clicking on the Stop button.

If the picture also contains alpha (key) information,
then select Send Picture & Alpha from the
MultiBuffer menu. The alpha channel will be sent
to the buffer selected as the alpha buffer after the
RBG picture is sent to the primary buffer. If you
wish to only send the alpha channel, then select
Send Alpha Only .

To send the monochrome content of the picture to
the MultiBuffer, select Send Y Only from the
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MultiBuffer menu. This sends the luminance
component of the picture to the primary buffer.

Note: If you hold the Option key down while you
select one of the Send functions, the image is sent to
the other channel. The encoded image will be sent to
the alpha buffer and the alpha component will be
sent to the primary buffer.

Adjusting the Digital Encoder/Transcoder

Envoy uses a high precision digital
encoder/transcoder and filters to convert the RGB
information contained in the picture to the digital
composite or component format. You can modify
some of the encoder parameters by selecting Send
Setup from the MultiBuffer menu as shown
below.

Note: Setup level only appears when a DS-2 buffer
is selected as the Primary buffer. Setup level is not
applicable for DS-1.
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The Gain and Chroma Gain can be set from 0 to
200 percent of unity gain. Note that a very high
gain setting can result in clipping. Also, setting the
chroma gain beyond 75% may result in illegal
NTSC colors.

The Invert Alpha check box will reverse the levels
sent to the alpha channel. The black areas of the
image as seen on the Mac screen will be translated
to white and the white areas to black.

Envoy utilizes two digital filters. The Filter affects
the horizontal domain of the picture and has
separate luminance and chroma filtering for
optimum frequency response. It has three possible
settings: Off, which removes all horizontal filtering
(which may create an illegal NTSC picture);
NTSC/PAL which filters the picture for proper
NTSC or PAL output; and Low Pass , which
provides an extra amount of filtering to remove
edging effects from some pictures.

The Vertical Filter provides for filtering in the
vertical domain to reduce the effect of converting a
high resolution Macintosh picture to an interlaced
NTSC image. The three settings are: Off , which
turns off all vertical filtering; Partial , which
provides some filtering in the vertical domain; and
Full , which provides full vertical filtering to
eliminate any inter-field flicker that may result
from alternate vertical lines in the original picture.

Note: If you send a picture to the MultiBuffer that
was previously transferred from the  MultiBuffer,
turn both filters off - extra filtering should not be
required unless you've modified the picture with
extra graphics.
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Capturing a Picture Using Pulldown Menus

An alternate method to using BufferPorts to
capture a picture is to us the Capture Picture
from the MultiBuffer pulldown menu. A picture
that has been frozen in the MultiBuffer can be
transferred to Envoy by selecting this function. The
entire 2 field digital component or 4 field digital
composite image from the buffer selected as the
primary channel will be transferred into Envoy and
then decoded and displayed in the Envoy Picture
window. While the image is being transferred, a
status box (illustrated below) will appear to
indicate the progress of the transfer.

To retrieve alpha information, select Capture
Alpha from the MultiBuffer menu. The image
from the buffer selected as the alpha channel will
be transferred into Envoy and the luminance
information from that image will be stored in the
alpha component of the Envoy Picture . To view
the alpha channel of the Envoy Picture, select
Show Alpha from the View menu.

Note: If you hold the Option key down while you
select either of these Capture functions, the image
is retrieved from the other channel.
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Adjusting the Digital Decoder/Transcoder

After an image is captured, the two field digital
component (or four field digital composite) image
data is held in a special buffer within Envoy. After
the transfer, it is automatically decoded (or
transcoded) into a 24 bit picture and displayed in
the Envoy Picture window. You can change the
decoding/transcoding parameters and convert the
image again by using the Capture Setup window.
Select Capture Setup from the MultiBuffer
menu to bring up the window, as shown below.

The Capture Setup window allows you to adjust
Gain , Chroma level and Offset level. In addition,
you can specify which fields are transcoded and
what to extract from the digital data.
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Overall Gain adjusts both the luminance and
chroma values of the resulting 24 bit RGB picture.

The Offset level adjusts the post-transcoder offset
of the entire image and is useful for adjusting the
black level of the picture.

The parameters of these adjustments can be
changed by either clicking on the up/down arrows
or by selecting the parameter value and entering in
a new value. Parameters must be within the range
indicated in parenthesis.

The Capture Range pop-up menu allows you to
choose which fields will be used for
decoding/transcoding of the image. 

The Capture Mode pop-up menu changes the way
the digital image is transcoded into the resultant
RGB picture. Normal mode decodes/transcodes the
image into a full color 24 bit RGB picture. Best
results are obtained when using the All Field
Decode Range. Mono mode extracts just the
luminance information and creates a grey-scale
image.

If the last image retrieved was an alpha channel
(using Capture Alpha ), then the decoder always
uses the Mono mode.

Once you have modified the parameters, click on
the Update button to decode the image saved in
the MultiBuffer into the Envoy Picture window.
This can be repeated until the picture has the
desired color quality.
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Saving the Captured Picture

To save the current Envoy Picture, select Save as
from the File menu. The Save dialog allows you to
save the picture in the following file formats:

• 32 bit PICT file (which includes the alpha
channel)

• Envoy Component Picture file (for MultiBuffer
DS-1)

• Envoy Encoded Picture (for MultiBuffer DS-2)

Saving it as a PICT file allows you to display or
modify the file by using any other Macintosh
application that supports pictures.

If you don't need to modify the picture, but wish to
save it for later loading and transfer back to the
MultiBuffer, you may wish to save it as an Envoy
Component or composite file, which saves the raw
digital composite or component information. This
method allows you to save images without any loss
as it completely skips the decode/encode/transcode
process and will return the exact image
information when you send it back to the
MultiBuffer. Note that none of the settings in the
Capture Setup apply when saved in this form
since the image is never decoded or transcoded.

Icons of the files saved with Envoy will show a
thumbnail of the picture you saved. For Envoy
Component files, a tiny C appears in the lower
right corner to help identify the file type.

Copying the Picture to the Clipboard

You can copy all or part of the Envoy Picture to the
clipboard, which can be later pasted into another
application, by selecting Copy in the Edit menu.
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You can also select a portion of the Envoy Picture
for copying by holding the Option key and dragging
a selection rectangle in the Envoy Picture window.
The copy function will then copy only the contents
of the selection rectangle.

Dragging the Picture to Another Application or Desktop

You can drag the Envoy Picture to the Finder or
other applications that support Drag and Drop.
Simply click anywhere in the Envoy Picture window
and drag the picture to the desired location. Only
those applications whose windows highlight while
dragging the picture over them can accept the PICT
image.

Envoy Preferences

There are a few user settings available to allow cus-
tomization of Envoy. Selecting Preferences from
the File menu brings up a window (see below) that
allows changing these settings.

Network size

This allows you to set Envoy's internal network
timing and transfer characteristics to the best
setting for your network configuration. 
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Use the following guidelines when making this
setting:

Small is best when you just have one or two Macs
connected to one or two MultiBuffers without any
other devices on your network.

Medium should be used if there are other devices
on your network, such as Laser printers and other
Macs not using the Multibuffers. Medium is also
appropriate if you have any routers or bridges on a
small network.

Large is best if your network contains many (>30)
other Macs or there are quite a few routers (more
than two zones) in your network. Also, this setting
may work best if using a LocalTalk to Ethernet
bridge for transferring pictures to a MultiBuffer.

Auto-view picture window

This setting determines whether the Envoy Picture
window will be automatically shown (if hidden)
after executing certain functions. When checked,
the window will become visible when opening an
Envoy picture file from Finder or after a capture
(including a BufferPort capture). Otherwise, it will
stay hidden.

Send document when opened

When set, a picture will be automatically sent to
the primary buffer when opened using any method
described earlier. This is useful if you want to
simply double-click a picture file in Finder and
have it opened and sent automatically.
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Envoy Reference
Apple Menu

About Envoy...

This will display the current version of Envoy along
with the model and version numbers of the
MultiBuffer assigned as the Primary buffer. If
Envoy cannot connect to the primary buffer, then "-
--" is displayed instead of the version numbers.
This provides a useful test of your network
connection if you're having problems transferring a
picture.

File Menu

Open...

Opens a PICT file or Envoy Picture file, reads the
picture into memory and displays it in the Envoy
Picture window. The original file remains
untouched. If Send document when opened in
the Preference window is checked, the picture is
immediately sent to the primary default buffer.

Save As...

Saves the current Envoy Picture as either a 32 bit
PICT file, Envoy Encoded Picture file (for DS-2) or
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an Envoy Component Picture file (for DS-1). If a
selection box is active in the Envoy Picture, only
that part is saved, otherwise the entire picture is
saved.

New BufferPort...

Creates a new BufferPort. Refer to the section
Creating a New BufferPort for more
information.

Preferences...

Shows the Preference selection window. Refer to
the section on Envoy Preferences for more
information.

Quit

Quits the Envoy application. All settings, including
those of the BufferPorts, are saved and will be
restored next time Envoy is run.

Edit Menu

Undo

Unused in the Envoy application.

Cut

Unused in the Envoy application.

Copy

This is active if the Envoy Picture window is visible
and a picture has been loaded or captured into the
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Envoy Picture window. It allows you to copy the
current Envoy Picture into the Clipboard for trans-
ferring to other applications. It may require up to
800K of free Envoy application memory to perform
the copy.

Paste

This is active if the Envoy Picture window is visible
and there is a picture available in the Clipboard.
The Clipboard picture will be pasted into the Envoy
Picture.

Clear

This is active if the Envoy Picture window is visible
and will clear the current picture.

View Menu

Show/Hide Picture Window

Shows or hides the Envoy Picture window. The
window can also be hidden by clicking in its close
box. When using BufferPorts, pictures will be
transferred faster if the window is hidden.

Auto EdgeMatch

When checked, any edges from pictures that are
smaller than the current window size will be filled
with either the predominate color from each of the
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four edges, or black. This filling only occurs as a
PICT file is opened.

Dither

When checked, the picture display will be enhanced
when shown on monitors not equipped with 24 bit
color. It has no effect on the image to be sent to the
MultiBuffer.

Show Alpha

When checked, displays the contents of the alpha
channel for the current picture. This may require
up to 400K of free Envoy application memory.

Width

This allows the Envoy Picture window width to be
changed to support the standard 640 pixel width of
Mac images, the 720 pixel width of digital
component images, or the 768 pixel width of digital
composite images. Refer to the section Envoy
Picture Size for more information.

Crosspoint Control...

This opens a Crosspoint Control window, which
is only available when the Primary buffer is
selected. It allows control of the internal
crosspoints within the MultiBuffer. The window,
similar to that shown below, may vary in
appearance depending on the options installed in
your MultiBuffer.
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Each pop-up menu in the window represents a
signal destination within the MultiBuffer. The
current source for each destination is displayed in
the pop-up menu. Clicking on any menu presents a
list of sources available and allows selection of any
source, allowing you to change the buffer inputs,
output sources, and other internal signal paths
within the MultiBuffer.

MultiBuffer Menu

Send Picture

Sends the current Envoy Picture to the primary
buffer.

Send Picture & Alpha

Sends the current Envoy Picture to the primary
buffer followed by the alpha component of the
Envoy Picture to the alpha buffer.

Send Alpha Only

Sends the alpha component of the current Envoy
Picture to the alpha buffer.
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Send Y Only

Sends the luminance component of the Envoy
Picture to the primary buffer.

Send Setup...

Displays the Send Setup window, which allows
modification of the Envoy digital
encoder/transcoder parameters. Refer to Adjusting
the Digital Encoder/Transcoder for more
information.

Capture Picture

Retrieves the image from the primary buffer of the
MultiBuffer and decodes or transcodes it into the
24 bit RGB Envoy Picture.

Capture Alpha

Retrieves the image from the alpha buffer of the
MultiBuffer and decodes it into the 8 bit alpha
component of the Envoy Picture. To view the alpha
image, select Show Alpha in the View menu.

Capture Setup...

Brings up the Capture Setup window, which
allows modification of the Envoy digital
decoder/transcoder parameters. Refer to
Adjusting the Digital Decoder/Transcoder for
more information.

Select Buffers...

Lets you choose a different primary or alpha
default buffer. These buffers are the default source
or destination buffers for transfers from a pulldown
menu or plug-in.
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Scripting With Envoy
Envoy supports AppleScript for automating tasks like
batch transcodes from PICT to Envoy file format and
still store operations. Some scripts are included on
your Envoy installation disk. You can use these scripts
as they are or modify them as needed.

Envoy Scripts

Included on the Envoy Mac disk are some
AppleScripts which can be used with Envoy. These
scripts are intended as models which you may
modify to suit your needs. While each of these
scripts has been used, please note that these scripts
are samples and may not have been rigorously
debugged.

If scripts are to be used the Envoy icon should be
labeled "Envoy", as this is the name the scripts are
expecting. In the Scripts folder are several scripts
and "Uptime". Open your Extensions folder and
drag "Uptime" on to the Scripting Additions icon
to place it in that folder. This program is used to
perform timing functions within the scripts.

Still Store Scripts

When a folder of files is dropped on a Still Store
icon the files in the folder are transferred in alpha-
betical order to the MultiBuffer as the Take button
is activated.

PICT Conversions

When a folder of files is dropped on a conversion
icon the files in the folder are converted from PICT
files to Envoy Component (YUV) for DS-1 or Envoy
Encoded for DS-2.
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DS-1 GPI Animation Layoff

Sends the contents of a folder to the primary buffer
and generates a GPI #5 output after each transfer.
The disk machine must be programmed to then
record this frame and move ahead one frame.

Capture Frames

This script will capture a sequence of frames from
an A62 disk recorder to your MultiBuffer DS-2 and
save them to a numbered sequence of files. You will
have to edit the script to provide the proper path to
the folder where the files are to be saved:

set pathName to "GraphicsHD:Desktop Folder:Envoy
Scripts:GetIt:" -- folder name is "GetIt"

DS-2 to A61

When a folder of files is dropped on the "DS2 to
A61" icon the files in the folder are transferred in
alphabetical order to the MultiBuffer DS-2. After
each transfer an active low  pulse of >50mS is
output on pin 6 of the DS-2 GPI connector. Pin 6 is
the Input A lamp indicator. The pulse is generated
by switching the input from A to B to A. As the
buffer is already frozen prior to this operation the
switching of inputs has no effect on DS-2 operation.

The "DS2 to A61 w/alpha" script operates
identically except that the GPI pulse is generated
after transfer of the alpha channel to the 2nd
buffer. Rather than make use of the GPI returned
to the DS-2 from the A61, it was more straightfor-
ward to simply have the scripts delay for 3 seconds
before transfer of the next picture to the
MultiBuffer DS-2 begins to allow time for the A61
to complete recording of the frame. The scripts are
commented, so you could edit the script to reduce
this value if it is excessive.
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Envoy Dictionary For AppleScript

To see the Envoy dictionary on your Mac, open the
Script Editor and go to the Envoy Dictionary .

Required Suite: Terms that every application
should support

open: Open the specified object(s)

open alias  -- list of objects to open

print: Print the specified object(s)

print alias  -- list of objects to print

quit: Quit application

quit

run: Sent to an application when it is double-
clicked

run

Envoy Suite: Events supported by Envoy

load: Load an image into Envoy.

load alias  -- PICT or Envoy Encoded/Component file

[send boolean]  -- Set to True to send the image to the 
MultiBuffer.

[offset point]  -- Image offset - default will center the 
image.

[EdgeMatch boolean]  -- Set to True to enable 
EdgeMatch or False to disable EdgeMatch.

[compositing boolean]  -- Set to True to add this 
image on the old one (the old image is not erased).

[transfer mode small integer]  -- Quickdraw transfer
mode
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save: Save an Envoy image.

save alias

[as type picture file/Envoy encoded/Envoy 
component]  -- Save the Envoy image as this file type.

[replace boolean]  -- If True, an existing file will be 
replaced.

send: Send image to MultiBuffer.

send color/alpha/color and alpha/luminance/video buffer

[to string]  -- Buffer name to send to.

[in zone string]  -- The buffer's AppleTalk zone.

[vertical filter off/partial/full]  -- Vertical filtering for 
this send.

[unity boolean]  -- Set to True to set encoder settings 
to unity.

[quiet boolean]  -- Set to True for a quiet transfer (no 
status window).

capture: Capture image from MultiBuffer.

capture color/alpha/color and
alpha/luminance/video buffer

[from string]  -- Buffer name to capture from.

[in zone string]  -- The buffer's AppleTalk zone.

[unity boolean]  -- Set to True to set decoder settings 
to unity.

[quiet boolean]  -- Set to True for a quiet transfer 
(no status window).

stop transfer: Stops a send or capture.

stop transfer
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buffer list: Returns a list of MultiBuffer buffer
names.

buffer list

[in zone string]  -- AppleTalk zone to search.

Result: string

primary buffer name: Returns the name of the
primary buffer.

primary buffer name

Result: string

alpha buffer name: Returns the name of the
alpha buffer.

alpha buffer name

Result: string

busy: Determines if the MultiBuffer is busy and
cannot load, save, or transfer an image.

busy

Result:   boolean  -- Returns True if busy, False if free.

version: Return application version number.

version

Result: integer

buffer message: Send a message to the buffer.

buffer message string

[to string]  -- Buffer name to send to.

[in zone string]  -- The buffer's AppleTalk zone.
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DS-1 Freeze commands for AppleScript

Command Format: $0212 ZZ

For ZZ: Bit 0-3 0

Bit 4 0 = Normal, 1 = Freeze

Bit 6 1 = Toggle Freeze state

Bit 7 1 = Capture - unfreeze for 1 
frame then freeze

Message Format:  buffer message {2, 18, nn} to
"Buffer x"

Unfreeze nn = 0

Freeze nn = 16

Freeze toggle nn = 64

Capture nn = 128 unfreeze for 1 frame 
then freeze

Example to freeze Buffer 2:  buffer message {2, 18,
16} to "Buffer 2"

For more information on AppleScript, see your Mac
OS docs called "Using AppleScript" or refer to
Danny Goodman's "AppleScript Handbook", or Tom
Trinko's "AppleScript for Dummies".
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Troubleshooting Envoy Mac
This section gives some tips on specific troubleshooting
for the Envoy software. For other troubleshooting tips,
refer to the DS-1 Troubleshooting section in this
manual or to the MultiBuffer DS-2 manual.

You get an alert: "Transfer failed" or other error
message while transferring a picture to or from the
MultiBuffer

Check your AppleTalk or EtherTalk network. Bad
connections or heavy traffic can cause the transfer
to become corrupt and stop the transfer. Check
your network connection with the About Envoy... in
the File menu. Check the Network Status menu
on the front panel of your MultiBuffer.

You get an alert: "There is not enough application
memory to complete this operation."

If this message should appear, try adding a few
hundred K or more of memory allocation to Envoy
by selecting the Envoy icon in Finder , then
selecting Get Info from the File menu, and setting
the Preferred size. Envoy cannot be running when
this is set.
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CONTROL WITH ENVOY PC SOFTWARE

Overview
Envoy PC (v1.4.2 or later) is a version of Ensemble
Designs Envoy software which provides transport of
images via ethernet between a PC operating under
Windows NT, Windows 95 or Windows 98 and the
MultiBuffer DS-1. TCP/IP protocol is used to
implement the Ethernet interface. Double clicking the
Envoy PC icon starts the program and opens the
Main window. Clicking the Setup button allows
setting of the IP address of a DS-1 on the network. The
default address in this window is 192.0.3.216, the same
as the default address with which the DS-1 is shipped.
If a single DS-1 is employed using its default address,
it will not be necessary to change from the Envoy PC
default address found in this window.

A file is viewed by selecting the file and clicking the
View File button, or by simply double clicking the
filename. The file can also be dragged and dropped
onto the Envoy Picture window and it will be displayed
there. A file is sent to a DS-1 buffer by selecting the
file and clicking the associated Send button, or by
dragging and dropping the file on the appropriate
BufferPort. If the Picture Window is open this
picture can be sent to the DS-1 by dragging it to a
BufferPort and dropping it there. 

Clicking the Capture button on the Main menu opens
the Capture window. An image may be Captured from
a DS-1 buffer by clicking the Capture button for the
desired buffer. After the Capture completes, it will
appear on the PC screen in the Picture Window , and
can be saved by selecting Save As from the File menu.
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As the DS-1 is a ITU-R601/SMPTE259M device it
has a 720 pixel wide picture. Though our resizing
algorithms are rigorous, there is always some small
loss when a picture is resized, as picture
information is either interpolated or extrapolated.
Thus, working with 720 pixel width files will
produce optimal quality when using the DS-1.
However, the change is minimal and there will
likely be many cases where the convenience of
using 640 pixel width is the predominating factor.

Capture

Click Capture on the Main Menu and the
Capture window opens. Clicking Capture 1 , for
example, initiates a capture from Buffer 1. The
Progress Bar follows progress of the Capture.
When the Capture is complete the captured is
displayed in the Envoy Picture Window .

File Save

Opens the File Save menu. Filenames entered in
the Save As box must have .YUV, .BMP or .TGA
extensions. Upper or lower case may be used. The
file is automatically saved in the format specified
by the extension. Double clicking a filename in the
File List box will cause the picture to be saved to
that filename.  The image saved will be the last file
viewed in the Envoy Picture window.

Filters

Filters are provided and may be used to get rid of
motion artifacts, or to minimize interfield flicker
caused by single pixel horizontal lines. To apply a
filter, select the desired function from the View
menu. Filter status appears on the Main Menu in
the area beneath the Viewing Width caption. The
Field 1 or Field 2 filters cause a picture to be
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generated from a single field thus eliminating the
flicker effect caused by having apparently
unrelated information present in two fields of
motion video. The missing field is interpolated from
the Field 1 or Field 2 information.

Single pixel height horizontal lines tend to flicker
as the line is turned off and on at field rate. In the
Partial Vertical and Full Vertical filter modes
information from the line above and the line below
is added into the affected line to reduce the flicker
effect.

All filtering is done in YUV color space. Thus, only
Captured pictures or .YUV files will display the
effect of filtering on the computer screen. .TGA and
.BMP files will not display the effects of filtering on
the computer screen, but the selected filter will be
applied when the file is converted to YUV format
for transmission to the DS-1. Effects of the filtering
can be seen in the transferred picture at the DS-1
video output. 

A picture that is Captured with a filter selected will
display the effect of that filter on the computer
screen, and the Save function will cause the
filtered picture to be saved in the selected file
format. If a file is Viewed with a filter applied, and
then sent to the DS-1 via a drag and drop of the
picture on to a BufferPort, the filtered picture will
be transferred to the DS-1.

Freeze

Opens the Freeze Menu window. Allows
Unfreezing or Freezing each of the buffers.
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Routing

Opens the Routing window. Routing combinations
may be selected to switch input and output
crosspoints. Each is enacted when the Switch
button is clicked. When the window is opened, or
when a Switch is made, the DS-1 is interrogated
and its routing status is displayed in the Routing
window.

Send Picture

In the File List box of the Main Menu , select a
file. Either drag and drop it on one of the
BufferPorts, or click Send 1, for example, after
selecting the file. This will initiate a Send to
Buffer 1. The Progress Bar indicates the
progress of the Send. The picture in the Picture
Window may also be dragged onto a buffer port
and a Send will take place.

Sequences

The Sequences button allows for the Send or
Capture of a series of pictures. You can use this
capability with a GPI trigger of with a manual
button within Envoy.

Using the DS-1's GPI interface to Capture from a Disk
Recorder

The Send Sequence function may be used to
animate a set of numbered files to a disk recorder,
or DDR. These may be .YUV, .TGA or .BMP files,
such as pix1.tga, pix2.tga, pix3.tga, etc. The disk
recorder must first be programmed to record a
frame upon receipt of a GPI, and advance to the
next frame. Video is cabled from a DS-1 output to
the disk recorder input, and a GPI interconnect
cable is connected. The first file may be selected
from the File List Box in the Send Path window,
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or the file name can be typed into the File to Send
text box.

Click Continue , then enter the Number of Files
to Send . The Start Transfers button causes the
first file to be sent, then GPI Output 5 of the DS-1
is pulsed low to tell the disk recorder to record the
picture and advance to the next frame. The
remainder of the files are automatically transferred
in this manner. The GPI #5 Output appears on Pin
13 of the GPI connector on the rear panel of the
DS-1.

The Capture Sequence function provides for the
saving of a series of frames as numbered .YUV,
.TGA or .BMP files. The disk recorder must first be
programmed to advance to the next frame upon
receipt of a GPI, and to output that frame. Video is
cabled from the disk recorder output to a DS-1
input, and a GPI interconnect cable is connected.
The first file may be selected from the File List
Box in the Capture Path window, or the file name
can be typed into the Save As text box.

Click Continue , then enter the Number of Pix to
Get . The Start Transfers button causes the DS-1
buffer to be unfrozen for 100mS, then the picture is
transferred over Ethernet to the DS-1 buffer. It is
saved to the selected file name and the file number
is incremented. GPI Output 5 of the DS-1 is pulsed
low to tell the disk recorder to advance to the next
frame. The remainder of the frames are automati-
cally transferred in this manner and saved as a
numbered file sequence.
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Manually capturing a sequence from any video source

Envoy PC can capture a sequence of images from
any video source for frame reference and other
applications. It will freeze a buffer, capture the
image back into the workstation, then save the
image in a numerical sequential file name.

To perform a manual capture, in the Envoy PC
application go to the Sequence pulldown menu.
Select Capture and a window will open.

Select Single Capture and choose the directory
that you want to save to. Extensions that can be
used are  .yuv,  .tga, and .bmp. Using the YUV file
format eliminates the RGB colour space conversion
and gives you the best quality for frame reference.
Click the Continue button.

To capture and save images, press any key on the
keyboard (except space bar , enter , and return ),
or use the mouse and click the Next Transfer
button. Images will be named incrementally, ie:
telecine1.yuv, telecine2.yuv, telecine3.yuv.

Setup

Opens a window which allows you to change the IP
address. Enter the IP address of the MultiBuffer
with which you wish to communicate. Note that the
host computer and the DS-1 must have IP
addresses with identical first 3 digits, or "dot
numbers".

In WinNT the host computer IP address may be
found by opening a DOS window and using the
"ipconfig " command. If operating under Win95 or
Win98, it is necessary to use Control Panels to find
this network address information. The DS-1 IP
address is found or changed in the Network menu,
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Ethernet sub-menu of the DS-1. To resume
operation you must close the Setup window in
Envoy PC before proceeding.

A DS-1 may be given a name and that name used
in the Setup menu instead of the IP address if the
Hosts file contains an entry to provide this
translation.

In WinNT 4.0 this file is located as follows:
c:\WINNT\system32\drivers\etc\HOSTS . In
Win95 and Win98, a file named Hosts.sam is
found in c:\Windows . The Hosts file may be edited
with an ASCII word processor, such as Notepad or
Wordpad and must be saved with no extension,
simply the filename HOSTS .

Note that some word processors automatically add
the extension .txt to a text file. In such a case,
locate the file with the Find function, or with
Explorer, and remove the extension.

If Explorer does not show file extensions, a setting
under the Explorer View menu must be changed.
Under View. click Options . The check box for
Hide Extensions for Known File Types must be
unchecked.

If, for example, these entries are added to the
Hosts file:

192.0.3.216  1stDS1 # comment field

192.0.3.218  2ndDS1# comment field

then entering 2ndDS1 into the dialog box in the
Setup menu will cause the DS-1 having IP address
192.0.3.218 to be the active DS-1 with which Envoy
PC communicates. Using the Hosts file for
translation can simplify selection of a DS-1 in
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Envoy PC as the selection can then be made be by
name rather than by address. Note that the
"localhost" translation line must not be removed
from the Hosts file or the system will not function.

Test Patterns

Opens the Test Pattern window. Allows loading of
each Test Pattern to any buffer. Select the Test
Pattern wanted and the Buffer to which to send
it, and click the Load button.

Timing

Opens the Timing window. Inserting a number in
the V Phase box and clicking the button changes
the phase for this buffer to the new value. H Phase
works in a similar manner. Allowable values are +/-
1700 for H Timing and +/-525 for V Timing.

View

Allows selection of native or 640 pixel widths. In
native mode the picture is viewed in the width in
which it arrives. A DS-1 Capture is seen as 720
pixel width. BMP and TGA files are displayed in
640, 720 or 768 widths, depending on how they
were saved. If 640 pixel width is selected all input
is converted to a 640 pixel wide picture for viewing.
The is the proper width for the computer, thus
circles on the video monitor appear round when
viewed on the computer when Envoy PC is set to a
640 pixel viewing width. The View setting does not
affect the width in which files are saved, only the
way they appear on the PC screen.

Allow Resize causes the viewed picture to expand
or contract to conform to the dimensions to which
the Envoy Picture window has been sized. If No
Resize is selected the displayed picture will be
cropped if the Envoy Picture window is made
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smaller than the default picture size. 

Allow Resize is useful when it is desired to see
the full picture while having the Envoy Picture
window take up less space on the desktop. The
resizing can cause artifacts to appear on the viewed
picture in the form of edges appearing less smooth
than they actually are. This is not directly related
to Envoy, but is produced by the resizing algorithm
used in the PC. Select No Resize to get the most
accurate view of the displayed picture.

TGA files with alpha

TGA files may be 24 bit format containing
bitmapped picture information. A 32 bit TGA file
also carries the alpha (hole cutter) channel along
with the picture (fill) information. Envoy PC
supports 24 and 32 bit TGA files in 640, 720 or 768
pixel widths. Double clicking the filename in the
File List box, or clicking the View File button,
allows viewing of the picture portion of the 32 bit
TGA file.

The alpha may be viewed by clicking the View
Alpha button. The operator can elect to Send just
the picture portion of a 32 bit TGA file to the
multibuffer, or both the picture and the alpha. This
option is selected under the File menu.

If Alpha Send is selected a corresponding notation
appears on the Envoy PC Main Menu beneath the
Viewing Width . The alpha channel is sent to the
next higher numbered buffer than the picture.
Thus, if a 32 bit TGA file is sent to Buffer 1 the
alpha channel will be sent to Buffer 2. If the 32 bit
file is sent to Buffer 4 the alpha is sent to Buffer 1.
The Alpha Send option has no effect on BMP files,
YUV files, or 24 bit TGA files.
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GPIs

When using the Sequences feature of Envoy PC, a
GPI output from the DS-1 is used to signal the disk
recorder to perform its next operation. For this
usage GPI #5, which appears on pin 13 of the GPI
connector on the rear panel of the DS-1, is used to
control the disk recorder. Only pin 13 and pin 15,
GND, need be connected for Sequence operation.
Following is complete listing of the DS-1 GPI
connections. (See also the GPI section in
MultiBuffer DS-1 Installation earlier in this
manual.)

DS-1 and CAT-CV GPI / Remote  "D" Connector

Pin 1 GPI In 1 Toggles Buffer 1 Freeze

Pin 2 GPI In 2 Toggles Buffer 2 Freeze

Pin 3 GPI In 3 Toggles Buffer 3 Freeze

Pin 4 GPI In 4 Toggles Buffer 4 Freeze

Pin 5* GPI In 5 Key Only, Cut

Pin 6* GPI In 6 Key Only, Mix

Pin 7* GPI In 7 Bkgd Only, Cut

Pin 8* GPI In 8 Bkgd Only, Mix

Pin 9 GPI Out 1 High when Buffer 1 is frozen

Pin 10 GPI Out 2 High when Buffer 2 is frozen

Pin 11 GPI Out 3 High when Buffer 3 is frozen

Pin 12 GPI Out 4 High when Buffer 4 is frozen

Pin 13 GPI Out 5 programmable

Pin 14 GPI Out 6 programmable

Pin 15 Gnd

* applies to CAT-CV with 0.9.4b27 or later PROMs
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Notes:

1. GPI inputs are active low, sampled at vertical
interval.

2. GPI Outputs require 470 ohms to LED when
used as a lamp driver.

3. When GPI Output is used as a logic output do
not use a pullup.  Use a 1N4148 diode in series
with the load for isolation,  with cathode toward
DS-1 for active low.

4. Requires firmware version 0.9.4b8 or later

Programmable GPI commands for 0.9.5.5 or later PROMs,
functional with Unix or PC:

rsh/rlogin commands: sendgpi 5|6  high|low|pulsehigh|pulselow
[duration]

to set programmable gpi '5' high, command is: sendgpi 5 high
<cr>

to pulse gpi 6 low for 2 ticks (1 tick = 16.6 msec) : sendgpi 6
pulselow 2 <cr>

'sg' can be used as shorthand for 'sendgpi'

there is online help: sg ? <cr>
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Envoy PC Troubleshooting
This section gives some tips on specific troubleshooting
for the Envoy software. For other DS-1 troubleshooting
tips, refer to the DS-1 Troubleshooting section at the
end of this manual.

DS-1 stops functioning

If you try to send two messages to the DS1 at the
same time or if an attempt is made to access a file
that is in use, the DS-1 can lock up and fail to
function. First, exit and restart Envoy PC.

If this does not solve the problem, it is then
necessary to power the DS-1 down and back up to
restore operation. The problem can be caused by
trying to send a file while another Send or
Capture is in progress.

Unable to Connect, Transfer Failure

Click the Setup button in the Envoy PC Main
Menu to find the Envoy IP address . Using the
Menu button on the DS-1 front panel, check the IP
address of the MultiBuffer .

If they are different, change either IP address so
they match. Note that the host computer and the
DS-1 must have IP addresses with identical first 3
dot numbers.

From WinNT the host computer IP address may be
found by opening a DOS window and using the
"ipconfig " command.

If operating under Win95 or Win98 it is necessary
to use Control Panels to find this network
address information.
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If the address is correct, the problem may be a bad
network connection. Check the Link LED on the
transceiver on the DS-1 and at the PC. Each should
be lit. Check the Hub. The Link Lights associated
with the PC and the DS-1 should be lit.

At the DS-1 use the Menu Func button and go to
Network Status , then Ethernet Status . It should
say Good Connection . If not, try Initializing
AppleTalk , or power the DS-1 down and back up
again. Note that Envoy has a 5 second timeout for
making a connection to the DS-1. There is a 15
second timeout for loss of connection during a
picture or data transfer.
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CONTROL WITH SGI OR UNIX PLATFORMS

MultiBuffer DS-1 can also be controlled by an SGI or
Unix application through TCP/IP. The Ethernet Local
Area Network (LAN) feature provides a straightfor-
ward means to transfer images with Silicon Graphics
and Unix workstations. Using standardized commands
already in use with other networked video devices, full
control of MultiBuffer functions and image transfers in
both directions can be integrated into the SGI/Unix
environment.

Under TCP/IP, MultiBuffer acts as a server. This
allows a user at an SGI/Unix station to connect in the
same manner used to access a central fileserver or
DDR. MultiBuffer DS-1 is given a user-assigned IP
(Internet Protocol) address in the form 192.X.X.XX
which provides a unique identification of the Frame
Store on the network. The IP address for MultiBuffer
DS-1 is added to the SGI/Unix Network Hosts list so
that it can be referenced by a meaningful device name
("ds1" is used in the examples which follow).

In this section, user commands are shown in bolded
text, system prompts and responses are shown in
normal typeface.

Operational control of MultiBuffer is provided through
the Unix rlogin (remote login) utility. The rlogin
command lets you log into MultiBuffer just as you
would any other server. rsh is also supported. When
connected via rlogin, on-line help is provided on all of
the commands available.

Images are transferred using the rcp (Remote Copy)
utility. This command lets you transfer image files
from a computer to MultiBuffer DS-1 and from the 
DS-1 to another computer. Both 8 bit YUV and 10 bit
YUV files are accepted.
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Getting Started
Set up a new host on the SGI/Unix workstation for the
MultiBuffer DS-1; it could be called "ds1" , as in the
examples given in this section.

Check the workstation to see what IP addresses are
available and set the MultiBuffer DS-1’s address as
needed from the frame front panel, or just use the
default address.

To set the MultiBuffer DS-1 IP address, go to the
Network Menu and arrow through to the IP address.
Press the down arrow to get to the menu for setting a
new address. The address is shown and entered in
Base10. Press ENT when done.

r Commands
These are the commands supported by the MultiBuffer
DS-1 under the rlogin Unix Utility. Assuming that
‘ds1 ’ has been referenced to the IP address of the
MultiBuffer DS-1 in the /etc/hosts file of the user ’s
machine, rlogin and rsh can be used with the
commands below.

rlogin Usage

An rlogin connection to MultiBuffer DS-1 is
generally established as follows:

sgi % rlogin ds1

Welcome to the MultiBuffer DS-1

ds1%

At this point a direct, fulltime connection has been
established between the user ’s keyboard and the
MultiBuffer DS-1. Using the command set
described below, the operator has complete control
over crosspoint routing, buffer freeze, timing, and
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other system parameters. The ‘ds1%’ prompt
indicates that communication is with the
MultiBuffer DS-1, and no longer with the unix shell
itself. An rlogin session is concluded by exiting,
logging out, or typing cntl-D.

rsh Usage

For ease of issuing single commands and construc-
tion of scripts these commands can be issued singly
through the rsh (remote shell) function under
Unix. As an example, the rsh invocation of the
freeze off command to buffer 1 would be as follows:

sgi % rsh ds1 freeze off buffer 1

Buffer 1 freeze off

sgi % 

Commands
config

Syntax: config

Displays the option configuration of the DS-1
indicating the number of SmartStore frame buffers
installed, the number of inputs (two are standard,
any more are options), and the number of outputs
(two are standard, any more are options).

Example:  Request the configuration.

ds1% config

Configuration of this MultiBuffer DS-1 is:

2   SmartStore(tm) Frame Stores

3   Serial Digital Inputs

2   Serial Digital Outputs

ds1%

84

Control with SGI or Unix Platforms



?

Syntax: ?

Displays the commands available under rlogin.

Example: Let’s get some info

ds1% ?

Commands for the MultiBuffer DS-1:

? Display this menu

config Display configuration of the DS-1

dm Display the content of a specific 
memory location

exit Exit remote login

freeze Freeze a buffer

genlock Display or set the genlock reference 
and line rate standard

help Display this menu

hostaddress Display the IP address of the DS-1

hostname Display or set hostname within DS-1

hphase Display or set the horizontal timing

info Display DS-1 system information

logout Exit remote login

mtp Make Test Pattern in a Buffer

route Queries and changes the DS-1's 
internal routing switcher

vphase Display or set the vertical timing

ds1%
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Note: Due to the way Unix treats ‘rsh ds1 ?’, the
‘help’ invocation of this command must be used.

help

Syntax: help

Displays the commands available under rlogin.
This is the same as the ‘?’ command.

exit

Syntax: exit  or cntl-D

Exits this invocation of rlogin, and returns to work
station operating system. (Note:  logout is an
equivalent command).

Example:  Let’s exit!

ds1% exit

sgi % 

Note: This command is nonsensical under rsh
since no login has actually taken place.

logout

Syntax: logout  or cntl-D

Logout from DS-1 and return to work station
operating system.

(Note: exit is an equivalent command).

Example:  Let’s logout!

ds1 % logout

sgi % 

Note :  This command is nonsensical under rsh
since no login has actually taken place.
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freeze

Syntax: freeze   [1 | 2  |  frame  |  off]  buffer
1|2|3|4

Display or change freeze status of one of four frame
buffers. The freeze status can be freeze field 1,
freeze field 2, freeze frame, or freeze off.

Example:  Query freeze status of Buffer 1, response
is that buffer 2 is in full frame freeze.

ds1% freeze buffer 2

ds1% freeze frame buffer 2

Example:  Unfreeze Buffer 1  (in terse form).

ds1% f o b1

Buffer 1 freeze off

ds1%

freeze ‘space’ function

Syntax: freeze  space buffer  1|2|3|4

Turns on a single key mode to freeze and unfreeze
a buffer. When the command is first issued this
control mode is entered and a message is displayed
prompting the user to use the space bar to toggle
the freeze state of the buffer. The mode is exited by
typing a carriage return.

Example:  Enter freeze space mode for buffer 2 and
toggle the freeze on and off, then exit.

ds1% freeze space buffer 2

Hit space bar to freeze and unfreeze buffer 2

buffer 2 freeze off <space>

buffer 2 freeze frame <space>

87

Control with SGI or Unix Platforms



buffer 2 freeze off <space>

buffer 2 freeze frame <cr>

ds1%

Note: This function works only in rlogin, not rsh.

hostaddress

Syntax: hostaddress [address (dotted decimal)]

Displays the IP address of the MultiBuffer DS-1.

Example:  Query the IP address

ds1% hostaddress

Host Address of the DS-1 is: 192.0.3.216

ds1%

hostname

Syntax: hostname [name - string]

Display or set the hostname within the MultiBuffer
DS-1. This name is used only as the rlogin prompt.
The hostname can be set to match the
workstation’s hostname file. This is particularly
useful if multiple MultiBuffers are used on a
common network.

Example:  Change the host name to ‘601’.

ds1% hostname 601

601%

88

Control with SGI or Unix Platforms



hphase

Syntax: hphase  buffer 1 | 2 | 3 | 4  [htiming
val] Set or display the horizontal timing value for
the selected buffer.

Example:  display H phase value of Buffer 2

ds1% hphase b2

hphase buffer 2 is -162

Example: Set Buffer 1 Hphase to +24

ds1% hphase b1 24

vphase

Syntax: vphase  buffer 1 | 2 | 3 | 4  [htiming
val]

Set or display the vertical timing value for the
selected buffer.

Example:  display V phase value of Buffer 1

ds1% vphase b1

vphase buffer 1 is 3

Example:  Set Buffer 1 Vphase to +24

ds1% vphase b1 24

vphase buffer 1 is 24

ds1%
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info

Syntax: info   [-e   -t    -i]

Display MultiBuffer DS-1 system information.

-e option provides information about Ensemble
Designs

-t displays tcp connection parameters and
status

-i displays ip connection parameters and status

Example:  an example

ds1% info -i

<ip connection parameters displayed here>

ds1%

mtp

Syntax: mtp buffer [ 1 2 3 4 ]  { pattern name }

This command causes a video test pattern to be
created in the designated buffer. Valid pattern
names are:

colorbar

crosshatch

safetitle

pulsebar

colorblack

Example:  Cause crosshatch to appear in buffer 2

ds1% mtp buffer 2 crosshatch

ds1%
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route

Syntax: route [source   destination] 

Queries and changes the DS-1’s internal routing
switcher. When the command is invoked without
any arguments, the entire state of the router is
displayed.  To make a crosspoint change, both a
source and destination must be supplied.

The video sources are:

Input 1

Input 2

Input 3 (if option is installed)

Input 4 (if option is installed)

Buffer 1

Buffer 2

Buffer 3 (if option is installed)

Buffer 4 (if option is installed)

The destinations are:

Output 1

Output 2

Output 3 (if option is installed)

Output 4 (if option is installed)

Buffer 1

Buffer 2

Buffer 3 (if option is installed)

Buffer 4 (if option is installed)

Because the SmartStore frame buffers in the
Multibuffer DS-1 have both an input and an
output, they are simultaneously sources and desti-
nations. Input x and Output y correspond to the
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serial digital inputs and outputs on the Catalyst
chassis.

This command supports a terse syntax, where
Output 2 shortens to o2.

The MultiBuffer DS-1 router is a fully populated x-
y matrix, so any source can feed any destination.

Example:

1) Query router settings,

2) then connect Input 2 to Output 1

3) and connect Buffer 3 to Output 2 in terse mode

ds1% route

Source    >>    Destination

Input  1          Buffer 1

Input  2          Buffer 2

Buffer 1          Buffer 3

Input  3          Buffer 4

Input  3          Output 1

Buffer 2          Output 2

Buffer 3          Output 3

Input  1          Output 4

ds1% route input 2 output 1

Source    >>    Destination

Input  1          Buffer 1

Input  2          Buffer 2

Buffer 1          Buffer 3

Input  3          Buffer 4
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Input  2          Output 1

Buffer 2          Output 2

Buffer 3          Output 3

Input  1          Output 4

ds1% r b3 o2

Source    >>    Destination

Input  1          Buffer 1

Input  2          Buffer 2

Buffer 1          Buffer 3

Input  3          Buffer 4

Input  2          Output 1

Buffer 3          Output 2

Buffer 3          Output 3

Input  1          Output 4

ds1%

genlock

Syntax: genlock  [ ref ]   [ std  ]

Display or set the genlock reference and line rate
standard.

Ref can take on:

ref a

ref b

input 1

freerun

Std can take on:

525

625
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Example:  Set to Reference A genlock at 525 line
rate

ds1% genlock ref a 525

ds1%

dm

Syntax: dm   [adr   count ]

Displays contents of specified memory location(s).
The beginning address, adr, is interpreted as a
hexadecimal value. The count, also in hex, specifies
the number of bytes to display. Count may not
exceed $100, larger values will be automatically
limited.

If the adr and count is omitted, the command will
repeat the previous count, starting at the next
location after the last dm command. This makes it
easy to display a block of memory larger than $100.

Note: This command is not for novices. It allows
unrestricted access to the processor’s full address
space. It can disturb system operation if a memory
mapped IO register is read out of sequence.
Additionally, since the full memory space is not
used, it can trigger a bus error which is a fatal
(though not necessarily tragic) circumstance. This
command is provided for engineering purposes and
it is described here only for completeness.
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Example:  Read $20 bytes starting at location
$1F8B2

ds1% dm 1F8B2   20

1F8B2   12 34 56 78 3B 8A 91 FC 9B 3D 84 91 37
BA CD 81

1F8C2   95 78 CD 9B 3D 84 91 37 3D 84 12 34 56
78 38 B5

ds1%

rcp Commands
Remote copy, rcp, is used in the Unix Shell for trans-
ferring images between the SGI and MultiBuffer DS-1

Transferring YUV Pictures

To send a YUV picture from the SGI to buffer 1 in
MultiBuffer DS-1, type this command in the shell:

rcp  filename ds1:001

To capture a picture in the MultiBuffer DS-1 and
copy it to the workstation in YUV format:

rcp ds1:001  filename

Transferring RGB Pictures

fromyuv and toyuv are utilities used with the DS-1
for transferring RGB graphics. They are readily
available and are often used with other video
equipment, such as disc recorders. They are
already installed on many workstations, usually
kept in /user/sbin.

To change a picture that was captured in YUV (the
MultiBuffer DS-1’s format) to RGB (the SGI’s
format and the one you can easily view on the SGI
screen):fromyuv  existing.filename    new.filename
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To change an RGB file to YUV:

toyuv    existing.filename   new.filename

Shell Scripts

Scripts can be created and iconized to simplify
graphics transfers for both sending and capturing.
Here are some examples:

SGI YUV File to DS1 YUV Script

For sending YUV files to MultiBuffer DS-1, create a
script with vi or jot or another editor. Give the
script a name such as ds1buf1 :

jot  ds1buf1

In the text editor window type:

rcp  $1  ds1:001 where $1 is the temporary
name for the picture

Then close the window. To check the permissions
for this script:

ls -l   ds1buf1

Permissions may need to be changed to enable read
and write in order to make the script executable:

chmod +x ds1buf1 where chmod is change
mode

Drag the icon onto the desktop or where ever is
convenient. Drag and drop a YUV file onto the icon
and the picture will automatically send to the
MultiBuffer DS-1.

96

Control with SGI or Unix Platforms



SGI RGB File to DS1 YUV Script

For a script to drag and drop RGB files, follow the
above steps and use this for the jot window:

toyuv $1 temp

rcp temp ds1:001

DS1 YUV to SGI RGB Script

For capturing RGB files, create a script.

Choose a shortened command such as grab. Type in
the Unix Shell:

jot grab

In the text editor window type:

rcp  ds1:001  tem

fromyuv  temp $1

By typing grab filename in the Unix Shell, contents
of MultiBuffer DS-1 Buffer 1 will be captured and
become a file in the workstation directory currently
in use.
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MULTIBUFFER DS-1 TROUBLESHOOTING

If you are experiencing problems with MultiBuffer 
DS-1 operation, refer to the section below for some
common troubleshooting tips.

Can't read LCD display on frame:

Adjust LCD display by pressing and holding down
the menu button then use the UP and DOWN
arrow keys to adjust the light and dark contrast as
desired.

Green lines on the output or no output:

Double check how the frame is genlocked. Is it
locked to an analog reference or to the digital
input? Now check the Genlock and Timing menu on
the frame. Be sure it is set correctly.

My Mac can’t send pictures to the MultiBuffer DS-1:

Be sure the Mac is set to Ethertalk . Go to
Control Panels under the Apple then to
AppleTalk . Set the window to connect via
Ethernet. Also check the MultiBuffer DS-1 IP
address in the Network Menu.

My PC can’t send pictures to the MultiBuffer DS-1:

Run Envoy PC and click the setup button. Enter
the IP address and click OK.
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PRODUCT SPECIFICATIONS

Inputs

Standard: 2 Serial Digital SMPTE 259M inputs with
reclocked active loopback outputs. 

Optional: 2 additional inputs

Analog component and composite support with Ensemble
Serial Box Converters

Outputs

Standard: 2 routable output channels, 2 buffered outputs
each, Serial Digital SMPTE 259M

Optional: 2 additional outputs

Analog component and composite support with Ensemble
Serial Box Converters

Internal SmartStore™ FrameBuffe rs

Standard: 2 SmartStore Digital Video Buffers

Full 4:2:2, timeable output

Input auto timing range: infinite

Optional: 2 additional buffers

Internal Format

10 Bit ITU-R 601 with 16 bit internal processing

Serial Interface

RS-422, DB 9 Connector, GV100/200 emulation

Genlock and T iming

Genlock reference selectable between 2 analog reference
inputs or digital video input #1
Output timing of each buffer fully adjustable over
complete frame

100



525/625 selectable

Ethernet

10 Mb Thinnet (10BaseT) or AUI
Upgradeable as options become available

Mechanical and Pow er

19” Wide, 1.75” High, 17” Deep; 
483 Wide, 44.5 High, 432 mm Deep
Weight 12 lbs; 5.5 kilos
100-230 VAC
50/60 Hz
60VA
CE Compliant as requested
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10BaseT (See also Ethernet)
Connection, 17

—A—
AAUI. See  also Ethernet
AppleScript. See  Envoy Mac
Scripting
AppleTalk, 27, 31, 32
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—B—
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Illustration, 12
BufferPorts. See Envoy Mac
Buffers (SmartStore)

Control, 21
Make Test Patterns, 21
Make 422 Patterns, 21
Make 444 Patterns, 22
Set Pattern IDs, 22
Set Default, 24
Description, 14
Freeze Control, 23
Timing, 23

—C—
Catalyst CV Option, 9
Computer Network Connections,
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Control Panel

Connection, 17

—E—
Edit Port Mode, 27
Editor Port, 16
Envoy Mac, 8, 30

Alpha Buffers, 34
Auto EdgeMatch Mode, 43
BufferPorts, 36

Alpha Buffer, 38
Capture Control, 37
Capturing an Image, 40
Creating New BufferPorts,
37
Dragging PICT or Envoy
File To, 39
Freeze Control, 37
Input Control, 37
Loading Picture, 40
Working with BufferPorts,
37
Capturing Picture, 48
Capture Alpha, 48
Capture Picture Pulldown,
48
Capture Setup, 49
Copying to Clipboard, 51
Dragging to Another
Application or Desktop, 52
Saving, 51

Envoy Picture Window, 43
Resizing, 44
Show Alpha, 44

Envoy Reference
Apple Menu, 54



Edit Menu, 55
File Menu, 54
MultiBuffer Menu, 58
View Menu, 56

File Formats, 51
Hardware Installation, 32
Overview, 30
Picture Size, 42

525 Applications, 42
625/PAL Applications, 42

Preferences, 42
Auto-View Picture Window,
53
Network Size, 52
Send document when
opened, 53

Primary Buffers, 34
Reference, 54
Scripting, 60

AppleScript, 60
Dictionary for AppleScript,
62
DS-1 Freeze Commands for
AppleScript, 65
Envoy Scripts, 60

Selecting Default Buffers, 34
Sending Picture

Send Setup Menu, 46
Sending Picture with
Pulldowns, 45

Software, 33
System Requirements, 31
Troubleshooting, 66
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TGA Files with alpha, 76
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Troubleshooting, 79
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AAUI for Mac, 32
Connections, 17
IP Address
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—F—
frame electronics, 12
FrameBuffers. See  Buffers
(SmartStore)
Freerun, 16
Freeze (Buffers), 23

control, 23
Front Panel Controls (Frame)

Menu Tree, 20
Menus, 20
Operation, 20

—G—
Genlock & Timing, 25
GPI, 18, 27

Pinouts, 18
Specifications, 19

—H—
H Timing

Buffers, 23

—I—
Inputs (serial digital), 12
Installation, 12

—L—
LCD Display Adjustment

Front Panel (Frame), 21
Line Standard, 25
LocalTalk, 31
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—P—
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—R—
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Remote Port Mode, 27
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—S—
Set Default, 17
Set Pattern IDs, 15
SGI Control. See Unix Control
Sync reference, 7

Analog Reference A or B, 7
Digital Input #1, 9
Freerun, 9
independent mode (analog
reference), 8
connection, 9
Jumpers (analog reference), 8
loop-through mode (analog
reference), 8
connection, 9

—T—
TCP/IP, 75
Thinnet

(10Base2), 10
BNC Connection, 11
Mac Connection, 25

Troubleshooting
MultiBuffer DS-1, 91

—U—
Unix Control

Commands, 77
? (help), 78
config, 77
dm (display memory), 87
exit, 79
freeze, 79
freeze ‘space’ function, 80
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genlock, 86
help, 79
hostaddress, 81
hostname, 81
hphase, 82
info, 83
logout, 79
mtp (make test pattern),
83
route, 84
vphase, 82

r Commands, 76
rcp (Remote Copy), 75
rcp Commands, 88
rlogin, 75
rlogin Usage, 76
rsh, 75
rsh Usage, 77
Shell Scripts, 89

DS1 YUV to SGI RGB
Script, 90
SGI RGB File to DS1 YUV
Script, 90
SGI YUV File to DS1 YUV
Script, 89

Transferring RGB Pictures,
88
Transferring YUV Pictures,
88

—V—
V Timing

Buffers, 16



106

Index



107



-vi-


